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3.0.1 Getting Started

Using ProModel requires a basic understanding of simulation methodology. PRO
MODEL recommends that you read through this chapter before beginning to 
construct your models to get a good overview of the various modeling elements. F
the ProModel shortcut panel seen here, you may run a demonstration model to s
how ProModel uses these various elements.

Open a model   Opens an existing model.

Install model package   Loads an existing model package.

Run demo model   Allows you to run a demonstration model.

www.promodel.com   Immediately connects you with the ProModel support pa
on the PROMODEL web site.

SimRunner    Activates SimRunner.

Stat::Fit   Allows you to launch Stat::Fit.
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3.1 Steps for Doing Simulation

3.1.1 Introduction

Doing simulation requires more than just knowing how to use a simulation produc
simulation study is, by its very nature, a project. Like any project, there are tasks 
completed and resources required to complete them. To be successful, a simula
project should be planned with an understanding of the requirements of each of 
tasks involved. Many failures result from hastily jumping into a simulation withou
first taking time to consider the steps involved and developing a plan for proceed

Simulation modeling requires good analytical, statistical, communication, organiz
tional, and engineering skills. The modeler must understand the system being 
investigated and be able to sort through complex cause-and-effect relationships 
determine system performance. At least a basic foundation in statistics is neede
properly design experiments and correctly analyze and interpret input and output
Ongoing communication with owners, stakeholders, and customers during a sim
tion study is also vital to ensure that a purposeful model is built and that everyon
understands the objectives, assumptions, and results of the study.

3.1.2 General Procedure

A decision to do a simulation usually results from a perception that simulation ca
help resolve one or more issues associated with the design of a new system or t
modification of an existing system. Before launching into a simulation project, on
more individuals should have been assigned to the study who have at least a ba
knowledge of the system to be studied and the issues of concern. Enough backg
information should have been obtained about the nature of the problem to determ
whether simulation is a suitable solution. If the simulation is being conducted by 
viduals inside the company, there may already be a basic knowledge of the oper
For outsiders or those unfamiliar with the operation, a brief description of the sys
and explanation of key issues should be provided. For an existing system, a faci
walk-through is an excellent way of getting familiar with the operation.

Once a suitable application or project has been identified as a candidate for sim
tion, decisions must be made about how to conduct the study. There are no strict
on how to perform a simulation study, however, the following steps are generally
ommended as a guideline (Shannon, 1975; Gordon, 1978; Law, 1991):

1. Plan the study

2. Define the system

3. Build the model

4. Run experiments
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5. Analyze the output 

6. Report results

Each step need not be completed in its entirety before moving on to the next step
procedure for doing a simulation is an iterative one in which activities are refined
sometimes redefined with each iteration. Describing this iterative process, Pritsk
and Pegden (1979) observe:

The iterative nature of this process is shown below:

Procedure for Conducting a Simulation Study

While the requirements for each step vary from simulation to simulation, the bas
procedure is essentially the same. The primary value of adopting this systematic
cedure, or one like it, is to ensure that the project is conducted in an organized, t
fashion with minimal waste of time and resources and maximum effectiveness in
achieving the objectives. 

Report 
Results

Analyze 
Output

Run 
Experiments

Define 
System

Build 
Model 

Plan Study
70 ProModel User’s Guide 



 Section 3.1  Steps for Doing Simulation

3.
1.

3

ing. 
ng of 

om-
g 

ues of 
ion 
t sim-
 
 valid 
types 

n 
t, 

c-

ce 
ded 

le?

 

of 
3.1.3 Step 1:  Planning the Study

Many simulation projects are doomed to failure from the outset due to poor plann
Undefined objectives, unrealistic expectations and a general lack of understandi
requirements frequently result in frustration and disappointment. If a simulation 
project is to be successful, a plan must be developed which is realistic, clearly c
municated and closely followed. Planning a simulation study involves the followin
sub tasks:

• Defining Objectives

• Identifying Constraints

• Preparing a Simulation Specification

• Developing a Budget and Schedule

Each of these tasks is discussed below.

Defining Objectives

With a basic understanding of the system operation and an awareness of the iss
concern or interest, one or more objectives can be defined for the study. Simulat
should only be used if an objective can be clearly stated and it is determined tha
ulation is the most suitable tool for achieving the objective. Defining an objective
does not necessarily mean that there needs to be a problem to solve. A perfectly
objective may be to see if there are, in fact, any unforeseen problems. Common 
of objectives for a simulation study include the following:

• Performance Analysis    How well does the system perform under a give
set of circumstances in all measures of significance (utilization, throughpu
waiting times, etc.)?

• Capacity Analysis   What is the maximum processing or production capa
ity of the system?

• Capability Analysis   Is the system capable of meeting specific performan
requirements (throughput, waiting times, etc.) and, if not, what changes (ad
resources, improved methods etc.) are recommended for making it capab

• Comparison Study   How well does one system configuration or design 
variation perform compared to another?

• Sensitivity Analysis   Which decision variables are the most influential on
one or more performance measures, and how influential are they?

• Optimization Study   What combination of feasible values for a given set 
decision variables best achieves desired performance objectives?
ProModel User’s Guide 71
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• Decision/Response Analysis   What are the relationships between the va
ues of one or more decision variables and the system response to those 
changes?

• Constraint Analysis   Where are the constraints or bottlenecks in the sys
tem and what are workable solutions for either reducing or eliminating tho
constraints?

• Communication Effectiveness   What variables and graphic representa-
tions can be used to most effectively depict the dynamic behavior or opera
of the system?

Defining the objective should take into account what the ultimate intended use o
model will be. Some models are built as “throw-away” models to be used only on
and then discarded. Other models are built to be used on an ongoing basis for c
ued “what-if” analyses. Some models need only provide a quantitative answer. O
require realistic animation to convince a skeptical customer. Some models are 
intended for use by only the analyst. Other models are intended for use by mana
with little simulation background and must be easy to use. Some models are use
make decisions of minor consequence. Other models are relied upon to make m
financial decisions.

Realizing the objectives of a simulation should consider both the purpose as we
the intended use of the model, the following questions should be asked when de
the objectives of the study:

• Why is the simulation being performed?

• Who will be using the model?

• To whom will the results of the simulation be presented?

• What information is expected from the model?

• Is this a “throw-away” model?

• How important is the decision being made?

Identifying Constraints

Equally as important as defining objectives is identifying the constraints under w
the study must be conducted. It does little good if simulation solves a problem if 
time to do the simulation extends beyond the deadline for applying the solution, 
the cost to find the solution exceeds the benefit derived. Objectives need to be te
pered by the constraints under which the project must be performed such as the
budget, deadlines, resource availability, etc. It is not uncommon to begin a simula
project with aspirations of developing an impressively detailed model or of creati
stunningly realistic animation only to scramble at the last minute, throwing togeth
crude model that barely meets the deadline. 
72 ProModel User’s Guide 
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Constraints should not always be viewed as an impediment. If no deadlines or o
constraints are established, there is a danger of getting too involved and detailed
simulation study and run the risk of “paralysis from analysis.” The scope of any 
project has a tendency to shrink or expand to fill the time allotted. 

In identifying constraints, anything that could have a limiting effect on achieving 
desired objectives should be considered. Specific questions to ask when identify
constraints for a simulation study include the following:

• What is the budget for doing the study?

• What is the deadline for making the decision?

• What are the skills of those doing the study?

• How accessible is the input data?

• What computer(s) will be used for the study?

Preparing a Simulation Specification

With clearly defined objectives and constraints, the simulation requirements can
specified. Defining a specification for the simulation is essential to projecting the t
and cost needed to complete the study. It also guides the study and helps set ex
tions by clarifying to others exactly what the simulation will include or exclude. A
specification is especially important if the simulation is being performed by an ou
side consultant so that you will know exactly what you are getting for your mone
Aspects of the simulation project to be contained in the specification include the 
following:

• Scope

• Level of detail

• Degree of accuracy

• Type of experimentation

• Form of results

Each of these specification criteria will be discussed in the following pages.

Scope    The scope refers to the breadth of the model or how much of the system
model will encompass. Determining the scope of the model should be based on
much bearing or impact a particular activity has on achieving the objectives of th
simulation. A common tendency is to model the entire system, even when the pr
lem area and all relevant variables are actually isolated within a smaller subsyste
for example, the objective is to find the number of operators required to meet a 
required production level for a machining cell, it is probably not necessary to mo
what happens to parts after leaving the cell. 
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The following figure illustrates how the scope of the model should be confined to
only those activities whose interactions have a direct bearing on the problem bei
studied. Upstream and downstream activities that do not impact the performance
sure of interest should be omitted from the model. In the following figure, since t
output rate from activity A is predictable, it can be modeled as simply an arrival r
to activity B. Since activity E never constrains output from activity D, it can also b
ignored.

Confining the Scope to Impacting Activities

Level of Detail    Project the level of detail defines the depth or resolution of the 
model. At one extreme, an entire factory can be modeled as a single “black box” 
ation with a random activity time. At the other extreme, every detailed motion of 
machine could be modeled with a one-to-one correspondence depicting the enti
machine operation. 

Unlike the model scope which affects only the size of the model, the level of deta
affects model complexity as well as model size. Determining the appropriate leve
detail is an important decision. Too much detail makes it difficult and time consum
to develop a valid model. Too little detail may make the model too unrealistic by 
excluding critical variables. The figure below illustrates how the time to develop a
model is affected by the level of detail. It also highlights the importance of includ
only enough detail to meet the objectives of the study.

Activity
A

Activity
B

Activity
C

Activity
D

Activity
E

Scope of Model
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Effect of Level of Detail on Model Development Time.

The level of detail is determined largely by the degree of precision required in the
put. If only a rough estimate is being sought, it may be sufficient to model each 
activity by its time, rather than specific details making up the activity. If, on the ot
hand, details such as downtimes or move times have an appreciable effect on th
come of the model, they should be included. 

Degree of Accuracy    The degree of accuracy pertains to the correctness of the
data being used. For some models or activities, the information need not be as a
rate or exact as it does for others. The required degree of accuracy is determine
the objectives of the study. If the decision is important or a comparison is close, 
greater accuracy may be required. Accuracy sometimes has to be sacrificed if re
information is simply unavailable such as when modeling a completely new syste

The required degree of accuracy can have a significant impact on the time and e
required to gather data. It often has little impact, however, on the model building 
since a model can be built with estimated values that can later be replaced with 
accurate values. Output precision is often governed by the degree of accuracy o
model. 

Type of Experimentation    The number and nature of the alternative solutions t
be evaluated should be planned from the outset in order to ensure that adequate 
allotted. This decision is often influenced by the deadline constraints of the study
Where alternatives with only slight differences are to be evaluated, a base mode
be developed that requires only minor modifications to model each alternative. If
alternative configurations are significantly different, it may require nearly as muc
effort modeling each configuration as it does developing the initial model.

Model Development Time

Level of
Detail

One to One

Minimum
Required

Correspondence
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For studies in which improvements to an existing system are being considered, i
often helpful and effective to model the current system as well as the proposed s
tem. The basic premise is that you are not ready to make improvements to a sys
until you understand how the current system operates. Information on the curren
tem is easier to obtain than information on areas of change. Once a model of the
current system is built, it is often easier to visualize what changes need to be ma
the modified system. Both systems may even be modeled together in the same s
tion and made to run side by side. During the final presentation of the results, be
able to show both “as is” and “to be” versions of the system effectively demonstr
the impact changes can have on system performance.

Form of Results   The form in which the results are to be presented can signifi-
cantly affect the time and effort involved in the simulation study. If detailed animat
or an extensive report is expected, the project can easily stretch on for several w
after the experimental phase has been completed. Many times the only result req
is a simple verification of whether a system is capable of meeting a production 
requirement. In such cases, a simple answer will suffice. 

Developing a Budget and Schedule

With objectives and constraints clearly defined and a specification prepared iden
ing the work to be performed, a budget and schedule should be developed proje
the expected cost and time for completing the simulation project. Obviously, the 
to perform a simulation project will vary depending on the size and difficulty of th
project. If data is not readily available, it may be necessary to add several additio
weeks to the project. A small project can take two to four weeks while large proje
can take two to four months. A simulation schedule should be based on realistic
jections of the time requirements keeping in mind the following:

• Defining the system to be modeled can take up to 50% of the project time

• Model building usually takes the least amount of time (10 to 20%).

• Once a base model is built, it can take several weeks to conduct all of the 
desired experiments, especially if alternative designs are being compared

While it may have initially been determined that simulation is a suitable tool for 
achieving the objective, the decision to use simulation may need to be reconside
light of projected cost and time estimates. Simulation may be a good solution to 
problem at hand, but if the time or the cost of doing the project outweighs the an
pated benefits, either an alternative solution may need to be explored or the obje
may need to be modified to cut down on the level of effort required.
76 ProModel User’s Guide 
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3.1.4 Step 2:  Defining the System

With clearly defined objectives and a well organized plan for the study, the syste
that will be simulated can begin to be defined in detail. This can be viewed as th
development of a conceptual model on which the simulation model will be based.
process of gathering and validating system information can be overwhelming wh
faced with the stacks of uncorrelated data to sort through. Data is seldom availa
a form that defines exactly how the system works. Many data gathering efforts en
with lots of data but very little useful information. 

Data gathering should never be performed without a purpose. Rather than being
hazard, data gathering should be goal oriented with a focus on information that w
achieve the objectives of the study. There are several guidelines to keep in mind 
gathering data.

• Identify cause-and-effect relationships    It is important to correctly 
identify the causes or conditions under which activities are performed. In g
ering downtime data, for example, it is helpful to distinguish between down
times due to failure, planned downtimes for breaks, tool change, etc., and
downtimes that are actually idle periods due to unavailability of stock. Onc
the causes have been established and analyzed, activities can be properly
gorized.

• Look for key impact factors   Discrimination should be used when gathe
ing data to avoid wasting time examining factors that have little or no impa
on system performance. If, for example, an operator is dedicated to a parti
machine and, therefore, is never a cause of production delay, there is no ne
include the operator in the model. Likewise, extremely rare downtimes, ne
gible move times, on-the-fly inspections and other insignificant or irrelevan
activities that have no appreciable effect on routine system performance m
be safely ignored. 

• Distinguish between time and condition dependent activities   
Time-dependent activities are those that take a predictable amount of time
complete, such as an inspection time. Condition-dependent activities can 
be completed when certain defined conditions within the system are satisf
Because condition-dependent activities are uncontrollable, they are unpre
able. An example of a condition-dependent activity might be filling a custom
order or performing an assembly operation that requires component parts
become available.

Many activities are partially time-dependent and partially condition-depend
When gathering data on these activities, it is important to distinguish betw
the time actually required to perform the activity and the time spent waiting
resources to become available or other conditions to be met before the ac
can be performed. If, for example, historical data is used to determine rep
ProModel User’s Guide 77
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times, the time spent doing the actual repair work should be used without 
including the time spent waiting for a repair person to become available. 

• Focus on essence rather than substance   A system definition for 
modeling purposes should capture the key cause-and-effect relationships 
ignore incidental details. Using this “black box” approach to system definiti
we are not concerned about the nature of the activity being performed, but 
the impact that the activity has on the use of resources and the delay of en
flow. For example, the actual operation performed on a machine is not imp
tant, but only how long the operation takes and what resources, if any, are
up during the operation. It is important for the modeler to be constantly thi
ing abstractly about the system operation in order to avoid getting too cau
up in the incidental details.

• Separate input variables from response variables   Input variables in 
a model define how the system works (e.g., activity times, routing sequenc
etc.). Response variables describe how the system responds to a given se
input variables (e.g., work-in-process, idle times, resource utilization, etc.)
Input variables should be the focus of data gathering since they are used t
define the model. Response variables, on the other hand, are the output o
simulation. Consequently, response variables should only be gathered to h
validate the model once it is built and run. 

These guidelines should help ensure that the system is thought of in the proper 
for simulation purposes. 

To help organize the process of gathering data for defining the system, the follow
steps are recommended:

• Determine data requirements.
• Use appropriate data sources.
• Make assumptions where necessary.
• Convert data into a useful form.
• Document and approve the data.

Each of these steps is explained on the following pages.

Determining Data Requirements

The first step in gathering system data is to determine what data is required for b
ing the model. This should be dictated primarily by the scope and level of detail 
required to achieve the model objectives as described earlier. It is best to go from
eral to specific in gathering system data. The initial focus should be on defining t
overall process flow to provide a skeletal framework for attaching more detailed 
information. Detailed information can then be added gradually as it becomes ava
able (e.g., resource requirements, processing times, etc.). Starting with the over
process flow not only provides an orderly approach to data gathering, but also en
78 ProModel User’s Guide 
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the model building process to get started which reduces the amount of time to b
and debug the model later. Often, missing data becomes more apparent as the m
is being built.

In defining the basic flow of entities through the system, a flow diagram can be us
as a way of documenting and visualizing the physical flow of entities from locatio
location. Once a flow diagram is made, a structured walk-through can be conduc
with those familiar with the operation to ensure that the flow is correct and that n
ing has been overlooked. The next step might be to define the detail of how entit
move between locations and what resources are used for performing operations
each location. At this point it is appropriate to identify location capacities, move 
times, processing times, etc. 

To direct data gathering efforts and ensure that meetings with others, on whom y
depend for model information, are productive, it may be useful to prepare a spec
list of questions that identify the data needed. A list of pertinent questions to be 
answered might include the following:

 1. What types of entities are processed in the system and what attributes, if an
tinguish the way in which entities of the same type are processed or routed?

2. What are the route locations in the system (include all places where process
queuing occurs, or where routing decisions are made) and what are their ca
ties (i.e., how many entities can each location accommodate or hold at one t

3. Besides route locations, what other types of resources (personnel, vehicles,
are used in the system and how many units are there of each type (resource
interchangeably may be considered the same type)?

4. What is the routing sequence for each entity type in the system?

5. What activity, if any, takes place for each entity at each route location (define
terms of time required, resources used, number of entities involved and any 
decision logic that takes place)?

6. Where, when and in what quantities do entities enter the system (define the
schedule, interarrival time, cyclic arrival pattern, or condition which initiates 
each arrival)? 

7. In what order do multiple entities depart from each location (First in, First ou
Last in, First out; etc.)?

8. In situations where an output entity could be routed to one of several alterna
locations, how is the routing decision made (e.g., most available capacity, fir
available location, probabilistic selection, etc.)?

9. How do entities move from one location to the next (define in terms of time a
resources required)?
ProModel User’s Guide 79
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10. What triggers the movement of entities from one location to another (i.e., av
able capacity at the next location, a request from the downstream location, a
external condition)?

11. How do resources move from location to location to perform tasks (define ei
in terms of speed and distance, or time)?

12. What do resources do when they finish performing a task and there are no o
tasks waiting (e.g., stay put, move somewhere else, etc.)?

13. In situations where multiple entities could be waiting for the same location o
resource when it becomes available, what method is used for making an ent
selection (e.g., longest waiting entity, closest entity, highest priority, preempt
etc.)?

14. What is the schedule of availability for resources and locations (define in term
shift and break schedules)?

15. What planned interruptions do resources and locations have (scheduled ma
nance, setup, changeover, etc.)?

16. What random failures do resources and locations experience (define in term
distributions describing time to failure and time to repair)?

Depending on the purpose of the simulation and level of detail needed, some of 
questions may not be applicable. For very detailed models additional questions 
need to be asked. Answers to these questions should provide nearly all of the inf
tion necessary to build a model. 

Using Appropriate Data Sources

Having a specific set of questions for defining the system, we are now ready to se
for the answers. Information seldom comes from a single source. It is usually the
result of reviewing reports, conducting personal interviews, personal observation
making lots of assumptions. “It has been my experience,” notes Carson (1986), 
for large-scale real systems, there is seldom any one individual who understands
the system works in sufficient detail to build an accurate simulation model. The m
eler must be willing to be a bit of a detective to ferret out the necessary knowled
Good sources of system data includes the following:

• Process Plans
• Time Studies
• Predetermined Time Standards
• Flow Charts
• Facility Layouts
• Market Forecasts
• Maintenance Reports
• Production Logs
80 ProModel User’s Guide 
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• Equipment Manufacturers
• Managers
• Engineers
• Shop Floor Personnel
• Facility Walk-throughs
• Comparisons with Similar Operations

In deciding whether to use a particular source of data, it is important to consider
relevancy, reliability and accessibility of the source. If the information that a parti
lar source can provide is irrelevant for the model being defined, then that source
should not be consulted. What good is a maintenance report if it has already bee
decided that downtimes are not going to be included in the model? Reliability of 
source will determine the validity of the model. A managers perception, for exam
may not be as reliable as actual production logs. Finally, if the source is difficult t
access, such as a visit to a similar facility in a remote site, it may have to be omi

Making Assumptions

Not long after data gathering has started, you may realize certain information is 
unavailable or perhaps unreliable. Complete, accurate, and up-to-date data for a
information needed is rarely obtainable, especially when modeling a new system
about which very little is known. For system elements about which little is known
assumptions must be made. There is nothing wrong with assumptions as long a
can be agreed upon, and it is recognized that they are only assumptions. Any design 
effort must utilize assumptions where complete or accurate information is lacking

Many assumptions are only temporary until correct information can be obtained 
is determined that more accurate information is necessary. Often sensitivity analysis, 
in which a range of values is tested for potential impact, can give an indication of
how accurate the data really needs to be. A decision can then be made to firm u
assumptions or to leave them alone. If, for example, the degree of variation in a p
ular activity time has little or no impact on system performance, then a constant 
activity time may be used. Otherwise, it may be important to define the exact dist
tion for the activity time.

Another approach in dealing with assumptions is to run three different scenarios
showing a “best-case” using the most optimistic value, a “worst-case” using the m
pessimistic value, and a “most-likely-case” using a best estimate value. This will 
determine the amount of risk you want to take in assuming a particular value.
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Converting Data to a Useful Form

Data is seldom in a form ready for use in a simulation model. Usually, some ana
and conversion needs to be performed for data to be useful as an input paramet
the simulation. Random phenomena must be fitted to some standard, theoretica
tribution, such as a normal or exponential distribution (see Law and Kelton, 1991
be input as a frequency distribution. Activities may need to be grouped together 
simplify the description of the system operation. 

Distribution Fitting  To define a distribution using a theoretical distribution 
requires that the data, if available, be fit to an appropriate distribution that best 
describes the variable. Several distribution fitting packages (e.g., BestFit, UniFit 
StatFit) are available to assist in fitting sample data to a suitable theoretical distr
tion. The alternative to using a standard theoretical distribution is to summarize t
data in the form of a frequency distribution that can be used directly in the mode
frequency distribution is sometimes referred to as an empirical or user-defined 
distribution.

Whether fitting data to a theoretical distribution, or using an empirical distribution
is often useful to organize the data into a frequency distribution table. Defining a
quency distribution is done by grouping the data into intervals and stating the 
frequency of occurrence for each particular interval. To illustrate how this is done
following frequency table tabulates the number and frequency of repairs for a pa
lar machine that required a certain frequency of repairs for a particular machine 
requiring a certain range of time to perform. 

Frequency Distributions of Repair Times

Total Number of Observations = 152

Repair Time 
(minutes)

Number of 
Observations

Percentage Cumulative 
Percentage

0 - 1 25 16.5 16.5

1 - 2 33 21.7 38.2

2 - 3 30 19.7 57.9

3 - 4 22 14.5 72.4

4 - 5 14 9.2 81.6

5 - 6 10 6.6 88.2

6 - 7 7 4.6 92.8

7 - 8 5 3.3 96.1

8 - 9 4 2.6 98.7

9 - 10 2 1.3 100.0
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While there are rules that have been proposed for determining the interval or cell
the best approach is to make sure that enough cells are defined to show a gradu
sition in values, yet not so many cells that groupings become obscured. 

Note in the last column of the frequency table that the percentage for each interv
may be expressed optionally as a cumulative percentage. This helps verify that a
100% of the possibilities are included. 

When gathering samples from a static population, one can apply descriptive stat
and draw reasonable inferences about the population. When gathering data from
dynamic and possibly time varying system, however, one must be sensitive to tre
patterns and cycles that may occur with time. The samples drawn may not actua
homogenous samples and, therefore, unsuitable for applying simple descriptive 
techniques.

Activity Grouping   Another consideration in converting data to a useful form is t
way in which activities are grouped for modeling purposes. Often it is helpful to 
group activities together so long as important detail is not sacrificed. This makes
models easier to define and more manageable to analyze. In grouping multiple a
ties into a single activity time for simplification, consideration needs to be given a
whether activities are performed in parallel or in series. If activities are done in p
lel or with any overlap, the time during which overlapping occurs should not be 
additive. 

If, for example, a part is loaded onto a machine at the same time a finished part 
unloaded from the machine, only the longest of the two times needs to be includ
Serial activities are always additive. For example, if a series of activities are per-
formed on an entity at a location, rather than specifying the time for each activity
may be possible to sum activity times and enter a single time or time distribution

Documenting and Approving the Data

When it is felt that all relevant information has been gathered and organized into
usable form, it is advisable to document the information in the form of data table
relational diagrams and assumption lists. Sources of data should also be noted. 
document should then be reviewed by others who are in a position to evaluate th
validity of the data and approve the assumptions made. This document will be he
later if you need to make modifications to the model or look at why the actual sys
ends up working differently than what was modeled. 

In addition to including those factors to be used in the model, the data documen
should also include those factors that are deliberately excluded from the model 
because they are deemed to be either insignificant or irrelevant. If, for example, b
times are not identified in the system description, a statement of explanation sho
be made explaining why. Stating why certain factors are being excluded from the
tem description will help resolve later concerns that may question why the factor
were omitted.
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Validating system data can be a time-consuming and difficult task, especially whe
many assumptions are made. In practice, data validation ends up being more of 
sensus or agreement confirming the information is good enough for the purpose
the model. While this approved data document provides the basis for building th
model, it often changes as model building and experimentation get under way.

3.1.5 Step 3:  Building the Model

Once sufficient information has been compiled to define the basic system operat
the model building activity can begin. While starting to build a model too early can
a wasted exercise, waiting until all of the information is completely gathered and
idated may unnecessarily postpone the building of the model. Getting the model
started before the data is completely gathered may even help identify missing in
mation needed to proceed. 

The goal of model building is to provide a valid representation of the defined sys
operation. Additionally, the model must be able to provide any other statistical or
graphical representation needed to satisfy the objectives of the study. A model is
ther true nor false, but rather useful or not useful. Once validated, a model is use
when it provides the needed information to meet the objectives of the simulation

Progressive Refinement

One nice feature of simulation is that models do not have to include all of the fin
detail before they will run. This allows a progressive refinement strategy to be use
which detail is added to the model in stages rather than all at once. Not only do 
els get built and running quicker this way, but it also makes models easier to debu
the initial stages of a model, for example, attractive graphics are not very useful 
since they are likely to be changed anyway, should not be added until later when
paring for the final model presentation. 

The complexity of model building should never be underestimated and it is alway
better to begin simple and add complexity rather than create an entire complex m
at once. It is also easier to add detail to a model than it is to remove it from a mo
Building a model in stages enables bugs to be more readily identified and correc
Emphasizing the importance of applying progressive refinement to model buildin
Law and Kelton (1991) have advised:

Although there are few firm rules on how one should go about the modeling process, one
point on which most authors agree is that it is always a good idea to start with a simple 
model which can later be made more sophisticated if necessary. A model should contain
only enough detail to capture the essence of the system for the purposes for which the 
model is intended: it is not necessary to have a one-to-one correspondence between ele
ments of the model and elements of the system. A model with excessive detail may be too
expensive to program and to execute.
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Incremental Expansion

In addition to adding complexity to a model in stages, models that have a broad s
are sometimes easier to build in phases where additional sections are added inc
tally to the model. This method of “eating the elephant one bite at a time” allows
portion of the model to be built, tested and debugged before adding new section
makes a large task more manageable. 

For unusually large models, it may be useful to identify definable boundaries with
model to permit model partitioning. Model partitioning is the process of subdividing 
model into two or more modules that represent physically separate sections withi
system. The purpose of model partitioning is to allow model sections to be built a
debugged, possibly even by separate individuals, independently of each other. O
sections are finished, they can be merged together to create the overall model. T
“divide-and-conquer” method of model building can greatly reduce the time and d
culty in building and debugging large models.

Model Verification

Once a model is defined using a selected software tool, the model must general
debugged to ensure that it works correctly. The process of demonstrating that a m
works as intended is referred to in simulation literature as model verification. It is 
much easier to debug a model built in stages and with minimal detail than to deb
large and complex model. Eliminating bugs in a program model can take a cons
able amount of time, especially if a general purpose programming language (e.g
C++) in which frequent coding errors occur is used. Most simulation languages p
vide a trace capability in the form of audit trails, screen messages, graphic anima
or some combination of all three. A trace enables the user to look inside of the si
tion to see if the simulation is performing the way it should. Good simulation 
products provide interactive debugging capability which further facilitates the deb
ging process. A thorough “walk-through” of the model input is always advisable.

Model Validation

During the process of model building, the modeler must be constantly concerned
how closely the model reflects the system definition. The process of determining
degree to which the model corresponds to the real system, or at least accurately
sents the model specification document, is referred to as model validation. Proving 
absolute validity is a non attainable goal. As Neelamkavil (1987) explains, “True 
idation is a philosophical impossibility and all we can do is either invalidate or fai
invalidate.” For this reason, what we actually seek to establish is a high degree oface 
validity. Face validity means that, from all outward indications, the model appear
be an accurate representation of the system. From this standpoint, validating a m
is the process of substantiating that the model, within its domain of applicability, 
sufficiently accurate for the intended application (Schlesinger, 1979).
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There is no simple test to establish the validity of a model. Validation is an induc
process through which the modeler draws conclusions about the accuracy of the
model based on the evidence available. Gathering evidence to determine model
ity is largely accomplished by examining the model structure (i.e., the algorithms
relationships) to see how closely it corresponds to the actual system definition. F
models having complex control logic, graphic animation can be used effectively a
validation tool. Finally, the output results should be analyzed to see if the results
appear reasonable. If circumstances permit, the model may even be compared t
actual system to see how they correspond. If these procedures are performed w
encountering a discrepancy between the real system and the model, the model 
to have face validity.

3.1.6 Step 4:  Conducting Experiments

The fourth step in a simulation study is to conduct simulation experiments with th
model. Simulation is basically an application of the scientific method. In simulatio
one begins with a theory of why certain design rules or management strategies a
better than others. Based on these theories the designer develops a hypothesis 
he tests through simulation. Based on the results of the simulation the designer d
conclusions about the validity of his hypothesis. In a simulation experiment there
input variables defining the model which are independent and may be manipulat
varied. The effects of this manipulation on other dependent or response variable
measured and correlated. 

In some simulation experiments we are interested in the steady-state behavior of the 
model. Steady-state behavior does not mean that the simulation produces a stea
outcome, but rather the distribution or statistical variation in outcome does not ch
over time. For example, a mass production facility may fluctuate between 200 an
220 parts per hour under normal operating conditions. For many simulations we
only be interested in a particular time period, such as a day run in a job shop. Fo
these studies, the simulation may never reach a steady state. 

As with any experiment involving a system with random characteristics, the resul
the simulation will also be random in nature. The results of a single simulation ru
represent only one of several possible outcomes. This requires that multiple replica-
tions be run to test the reproducibility of the results. Otherwise, a decision might 
made based on a fluke outcome, or at least an outcome that is not representativ
what would normally be expected. Since simulation utilizes a pseudo-random num
generator for generating random numbers, running the simulation multiple times
ply reproduces the same sample. In order to get an independent sample, the sta
seed value for each random stream must be different for each replication, thus e
ing that the random numbers generated from replication to replication are 
independent. 

Depending on the degree of precision required in the output, it may be desirable
determine a confidence interval for the output. A confidence interval is a range withi
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which we can have a certain level of confidence that the true mean falls. For a g
confidence level or probability, say .90 or 90%, a confidence interval for the aver
throughput rate of a system might be determined to be between 45.5 and 50.8 u
per hour. We would then be able to say that there is a .90 probability that the tru
mean throughput of the model (not of the actual system!) lies between 45.5 and 
units per hour.

Fortunately, ProModel provides convenient facilities for conducting experiments, 
ning multiple replications and automatically calculating confidence intervals. The
modeler must still decide, however, what types of experimentation are appropria
When conducting simulation experiments, the following questions should be ask

• Am I interested in the steady-state behavior of the system or a specific pe
of operation?

• How can I eliminate start-up bias or getting the right initial condition for the
model?

• What is the best method for obtaining sample observations that may be us
estimate the true expected behavior of the model?

• What is an appropriate run length for the simulation?

• How many replications should be made?

• How many different random streams should be used?

• How should initial seed values be controlled from replication to replication

Answers to these questions will be determined largely by the following three fact

• The nature of the simulation (terminating or nonterminating).

• The objective of the simulation (capacity analysis, alternative comparisons
etc.).

• The precision required (rough estimate versus confidence interval estimat

Terminating Versus Non-terminating Simulations

As part of setting up the simulation experiment, one must decide what type of sim
tion to run. Simulations are usually distinguished as being one of two types: 
terminating or non-terminating. The difference between the two has to do with 
whether we are interested in the behavior of the system over a particular period 
time or in the steady-state behavior of the system. It has nothing to do, necessa
with whether the system itself terminates or is ongoing. The decision to perform 
minating or non-terminating simulation has less to do with the nature of the syste
than it does with the behavior of interest. 
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A terminating simulation is one in which the simulation starts at a defined state o
time and ends when it reaches some other defined state or time. An initial state m
be the number of parts in the system at the beginning of a work day. A terminatin
state or event might be when a particular number of jobs have been completed. 
sider, for example, an aerospace manufacturer that receives an order to manufa
200 airplanes of a particular model. The company might be interested in knowing
long it will take to produce the aircraft along with existing workloads. The simulat
run starts with the system empty and is terminated when the 200th plane is comp
since that covers the period of interest. A point in time which would bring a termi
ing simulation to an end might be the closing of shop at the end of a business da
the completion of a weekly or monthly production period. It may be known, for ex
ple, that a production schedule for a particular item changes weekly. At the end 
each 40 hour cycle, the system is “emptied” and a new production cycle begins. 
this situation, a terminating simulation would be run in which the simulation run 
length would be 40 hours.

Terminating simulations are not intended to measure the steady-state behavior o
system. In a terminating simulation, average measures are of little meaning. Sin
terminating simulation always contains transient periods that are part of the anal
utilization figures have the most meaning if reported for successive time intervals
ing the simulation. 

A non-terminating or steady-state simulation is one in which the steady-state beh
of the system is being analyzed. A non-terminating simulation does not mean tha
simulation never ends, nor does it mean that the system being simulated has no
tual termination. It means only that the simulation could theoretically go on 
indefinitely with no statistical change in behavior. For non-terminating simulation
the modeler must determine a suitable length of time to run the model. An examp
a non-terminating simulation is a model of a manufacturing operation in which oi
ters are produced on a continual basis at the same pace. The operation runs two
with an hour break during each shift in which everything momentarily stops. Brea
and third shift times are excluded from the model since work always continues 
exactly as it left off before the break or end of shift. The length of the simulation 
determined by how long it takes to get a representative steady-state reading of t
model behavior. 

Running Terminating Simulations

Experiments involving terminating simulations are usually conducted by making 
eral simulation runs, or replications, of the period of interest using a different ran
seed for each run. This procedure enables statistically independent and unbiase
observations to be made on the system response over the period simulated. Sta
are often gathered on performance measures for successive intervals of time du
the period. 
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For terminating simulations, we are usually interested in final production counts 
changing patterns of behavior over time rather than the overall average behavior
would be absurd, for example, to conclude that because two machinists are only
an average of 40% during the day that only one machinist is needed. This avera
measure reveals nothing about the utilization of the machinists during peak perio
the day. A more detailed report of waiting times during the entire work day may 
reveal that three machinists are needed to handle peak periods, whereas only o
machinist is necessary during off-peak hours. In this regard, Hoover and Perry (1
note:

It is often suggested in the simulation literature that an overall performance be accumu-
lated over the course of each replication of the simulation, ignoring the behavior of the 
systems at intermediate points in the simulation. We believe this is too simple an 
approach to collecting statistics when simulating a terminating system. It reminds us of 
the statistician who had his head in the refrigerator and feet in the oven, commenting tha
on the average he was quite comfortable.

For terminating simulations, the three important questions to answer in running t
experiment are: 

1. What should be the initial state of the model?

2. What is the terminating event or time?

3. How many replications to make?

Many systems operate on a daily cycle, or, if a pattern occurs over a weeks time
cycle is weekly. Some cycles may vary monthly or even annually. Cycles need n
repeating to be considered a cycle. Some manufacturers, for example, may be i
ested in the ramp-up period of production during the introduction of a new produ
which is a one-time occurrence.

The number of replications should be determined by the precision required for th
output. If only a rough estimate of performance is being sought, three to five rep
tions are sufficient. For greater precision, more replications should be made unti
confidence interval with which you feel comfortable is achieved. 

Running Non-terminating Simulations

The issues associated with generating meaningful output statistics for terminatin
simulations are somewhat different that those associated with generating statisti
non-terminating systems. In steady-state simulations, we must deal with the follo
issues:

1. Determining the initial warm-up period.

2. Selecting among several alternative ways for obtaining sample observati

3. Determining run length.
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Determining the Warm-up Period    In a steady-state simulation, we are inter-
ested in the steady-state behavior of the model. Since a model starts out empty,
usually takes some time before it reaches steady-state. In a steady-state conditio
response variables in the system (e.g., processing rates, utilization, etc.) exhibit 
tical regularity (i.e., the distribution of these variables are approximately the sam
from one time period to the next). The figure below illustrates the typical behavio
a response variable, Y, as the simulation progresses through N periods of a simul

Behavior of Response Variable Y For Successive Periods During Simulation.

The time that it takes to reach steady-state is a function of the activity times and
amount of activity taking place. For some models, steady-state might be reached
matter of a few hours of simulation time. For other models it may take several hu
dred hours to reach steady-state. In modeling steady-state behavior we have the
problem of determining when a model reaches steady-state. This start-up period
usually referred to as the warm-up period. We want to wait until after the warm-up 
period before we start gathering any statistics. This way we eliminate any bias d
observations taken during the transient state of the model. 

While several methods have been presented for determining warm-up time (Law
Kelton, 1991), the easiest and most straightforward approach, although not nece
ily the most reliable, is to run a preliminary simulation of the system, preferably w
several (3 to 5) replications, and observe at what time the system reaches statis
stability. The length of each replication should be relatively long and allow even 
rarely occurring events, such as infrequent downtimes, to occur at least two or th
times. To determine a satisfactory warm-up period using this method, one or mor
response variables should be monitored by period over time, like the average nu
of entities in a queue or the average utilization of a resource. This approach ass
that the mean value of the monitored response variable is the primary indicator of
convergence rather than the variance, which often appears to be the case. If possibl
it is preferable to reset the response variable after each period rather than track 

Period

1

2

3

4

5

6

7

8

Y

Steady State

Transient State
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cumulative value of the variable, since cumulative plots tend to average out insta
in data. Once these variables begin to exhibit steady-state, we can add a 20% to
safety factor and be reasonably safe in using that period as the warm-up period.
approach is simple, conservative and usually satisfactory. Remember, the dange
underestimating the warm-up period, not overestimating it. Relatively little time a
expense is needed to run the warm-up period longer than actually required. The 
below illustrates averaging the number of entities processed each hour for sever
lications. Since statistical stability is reached at about 10 hours, 12 to 15 hours is
probably a safe warm-up period to use for the simulation.

Plot of Hourly Entity Output to Identify Start of Steady-State.

Obtaining Sample Observations  In a terminating simulation, sample observa-
tions are simply made by running multiple replications. For steady-state simulati
we have several options for obtaining sample observations. Two widely used 
approaches are running multiple replications and interval batching. The method 
ported in ProModel is running multiple replications.

Running multiple replications for non-terminating simulations is very similar to ru
ning terminating simulations. The only difference is that (1) the initial warm-up 
period must be determined, and (2) an appropriate run length must be determine
Once the replications are made, confidence intervals can be computed as descr
earlier in this chapter. One advantage of running independent replications is that
ples are independent. On the negative side, running through the warm-up phase
each replication slightly extends the length of time to perform the replications. Fu
thermore, there is a possibility that the length of the warm-up period is 
underestimated, causing biased results.

Simulation Time (hrs)
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End of Warm-up Period
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Interval batching (also referred to as the batch means technique) is a method in which 
a single, long run is made with statistics being reset at specified time intervals. T
allows statistics to be gathered for each time interval with a mean calculated for 
interval batch. Since each interval is correlated to both the previous and the next
vals (called serial correlation or autocorrelation), the batches are not completely
independent. The way to gain greater independence is to use large batch sizes 
use the mean values for each batch. When using interval batching, confidence in
calculations can be performed. The number of batch intervals to create should b
least 5 to 10 and possibly more depending on the desired confidence interval.

Determining Run Length    Determining run length for terminating simulations is
quite simple since there is a natural event or time point that defines it for us. Det
mining the run length for a steady-state simulation is more difficult since the 
simulation can be run indefinitely. The benefit of this, however, is that we can prod
good representative samples. Obviously, running extremely long simulations is 
impractical, so the issue is to determine an appropriate run length that ensures a
ciently representative sample of the steady-state response of the system is take

The recommended length of the simulation run for a steady-state simulation is d
dent upon (1) the interval between the least frequently occurring event and (2) th
type of sampling method (replication or interval batching) used. If running indepe
dent replications, it is usually a good idea to run the simulation enough times to 
every type of event (including rare ones) happen at least a few times if not sever
hundred. Remember, the longer the model is run, the more confident you can be
that the results represent a steady-state behavior. If collecting batch mean obse
tions, it is recommended that run times be as large as possible to include at leas
occurrences of each type of event (Thesen and Travis, 1992).

Comparing Alternative Systems

Simulations are often performed to compare two or more alternative designs. Th
comparison may be based on one or more decision variables such as buffer cap
work schedule, resource availability, etc. Comparing alternative designs requires
ful analysis to ensure that differences being observed are attributable to actual 
differences in performance and not to statistical variation. This is where running 
tiple replications may again be helpful. Suppose, for example, that method A for
deploying resources yields a throughput of 100 entities for a given time period w
method B results in 110 entities for the same time period. Is it valid to conclude t
method B is better than method A, or might additional replications actually lead t
opposite conclusion? 

Evaluating alternative configurations or operating policies can sometimes be per
formed by comparing the average result of several replications. Where outcome
close or where the decision requires greater precision, a method referred to as hypoth-
esis testing should be used. In hypothesis testing, first a hypothesis is formulated (
that methods A and B both result in the same throughput) and then a test is mad
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see whether the results of the simulation lead us to reject the hypothesis. The ou
of the simulation runs may cause us to reject the hypothesis that methods A and
both result in equal throughput capabilities and conclude that the throughput doe
indeed depend on which method is used.

Sometimes there may be insufficient evidence to reject the stated hypothesis an
the analysis proves to be inconclusive. This failure to obtain sufficient evidence t
reject the hypothesis may be due to the fact that there really is no difference in p
mance, or it may be a result of the variance in the observed outcomes being too
given the number of replications to be conclusive. At this point, either additional (
haps time consuming) replications may be run or one of several variance reduct
techniques might be employed (see Law and Kelton, 1991). 

Factorial Design

In simulation experiments we are often interested in finding out how different inp
variable settings impact the response of the system. Rather than run hundreds o
experiments for every possible variable setting, experimental design techniques 
be used as a “short-cut” to finding those input variables of greatest significance. U
experimental-design terminology, input variables are referred to as factors, and the 
output measures are referred to as responses. Once the response of interest has bee
identified and the factors that are suspected of having an influence on this respo
defined, we can use a factorial design method which prescribes how many runs to 
make and what level or value to be used for each factor. As in all simulation exp
ments, it is still desirable to run multiple replications for each factor level and use
confidence intervals to assess the statistical significance of the results. 

One's natural inclination when experimenting with multiple factors is to test the 
impact that each individual factor has on system response. This is a simple and 
straightforward approach, but it gives the experimenter no knowledge of how fac
interact with each other. It should be obvious that experimenting with two or mor
factors together can affect system response differently than experimenting with o
one factor at a time and keeping all other factors the same. 

One type of experiment that looks at the combined effect of multiple factors on s
tem response is referred to as a two-level, full-factorial design. In this type of 
experiment, we simply define a high and low level setting for each factor and, sin
is a full-factorial experiment, we try every combination of factor settings. This me
that if there are five factors and we are testing two different levels for each factor

would test each of the 25 = 32 possible combinations of high and low factor levels.
For factors that have no range of values from which a high and low can be chose
high and low levels are arbitrarily selected. For example, if one of the factors bei
investigated is an operating policy for doing work (e.g., first come, first served; or
come, last served), we arbitrarily select one of the alternative policies as the high
setting and a different one as the low level setting. 
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For experiments in which a large number of factors are being considered, a two-
full-factorial design would result in an extremely large number of combinations to
test. In this type of situation, a fractional-factorial design is used to strategically 
select a subset of combinations to test in order to “screen out” factors with little o
impact on system performance. With the remaining reduced number of factors, m
detailed experimentation such as a full-factorial experiment can be conducted in
more manageable fashion.

After fractional-factorial experiments and even two-level, full-factorial experiment
have been performed to identify the most significant factor level combinations, it
often desirable to conduct more detailed experiments, perhaps over the entire ra
values, for those factors that have been identified as being the most significant. T
provides more precise information for making decisions regarding the best facto
ues or variable settings for the system. For a more concise explanation of the us
factorial design in simulation experimentation see Law and Kelton (1991).

Use of Random Streams

One of the most valuable characteristics of simulation is the ability to reproduce 
randomize replications of a particular model. Simulation allows probabilistic phe-
nomena within a system to be controlled or randomized as desired for conductin
controlled experiments. This control is made available through the use of random 
streams.

A stream is a sequence of independently cycling, unique random numbers that a
uniformly distributed between 0 and 1 (see the figure on next page). Random nu
streams are used to generate additional random numbers from other probability 
butions (Normal, Beta, Gamma, etc.). After sequencing through all of the random
numbers in the cycle, the cycle starts over again with the same sequence. The le
of the cycle before it repeats is called the cycle period and is usually very long. 

Example of a Random Stream Cycle With a Very Short Period.

.52

.31

.60

.95

.66

.07

.25

.80
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A random stream is generated using a random number generator or equation. Th
dom number generator begins with an initial seed value after which, each succe
value uses the previous value as input to the generator. Each stream used in a s
tion has its own independent seed and tracks its own values for subsequent inpu
the generator. Where the sequence begins in the cycle depends on the initial se
value used by the generator.

Any time a particular number seeds a stream, the same sequence of values will 
repeated every time the same seed is used to initialize the stream. This means th
ious elements within a model can be held constant with respect to their performa
while other elements vary freely. Simply specify one random number stream for 
set of activities and another random number stream for all other activities.

Because the same seed produces the same sequence of values every time it is 
completely independent functions within a model must have their own streams fr
the start. For example, arrival distributions should generally have a random num
stream used nowhere else in the entire model. That way, activities added to a m
that sample from a random number stream will not inadvertently alter the arrival 
tern because they do not affect the sample values generated from the arrival 
distribution.

To show an example of how multiple streams can be useful, consider two machi
Mach1 and Mach2, which go down approximately every 4 hours for servicing. To
model this, the frequency or time between failures is defined by a normal distribu
with a mean value of 240 minutes and a standard deviation of 15 minutes, N(240
The time to repair is 10 minutes. If no stream is specified in the normal distributio
the same stream will be used to generate sample values for both machines. So,
next two numbers in the stream number are .21837 and .86469, Mach1 will get a
ple value from the normal distribution that is different from Mach2. Therefore, the
two machines will go down at different times.

Suppose, however, that the resource servicing the machines must service them b
the same time, so we would like to have the machines go down at the same time
Using the same stream to determine both downtimes will not bring them down a
same time, because a different random number will be returned from the stream
each call to generate a random normal variate. Using two different streams, eac
icated to a machine's downtime and each having the same initial seed, will ensur
both machines go down at the same time every time. The two streams have the 
starting seed value so they will produce exactly the same sequence of random 
numbers. 
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3.1.7 Step 5:  Analyzing the Output

Output analysis deals with drawing inferences about the actual system based on
simulation output. When conducting simulation experiments, extreme caution sh
be used when interpreting the simulation results. Since the results of a simulatio
experiment are random (given the probabilistic nature of the inputs), an accurate
surement of the statistical significance of the output is necessary. 

People doing simulation in academia are often accused of working with contrived
often oversimplified assumptions, yet are extremely careful about ensuring the s
tical significance of the model results. Simulation practitioners in industry, on the
other hand, are usually careful to obtain valid model data, only to ignore the statis
issues associated with simulation output. Maintaining a proper balance between
establishing model validation and establishing the statistical significance of simu
tion output is an important part of achieving useful results. 

The most valuable benefit from simulation is to gain insight, not necessarily to fin
absolute answers. With this in mind, one should be careful about getting too ped
about the precision of simulation output. With more than 60 combined years of e
rience in doing simulation modeling, Conway, Maxwell and Worona (1986) cautio
that attaching a statistical significance to simulation output can create a delusion
the output results are either more or less significant than they really are. They em
size the practical, intuitive reading of simulation results. Their guideline is, “If you
can't see it with the naked eye, forget it.”

The goal of conducting experiments is not just to find out how well a particular sy
tem operates, but hopefully to gain enough insight to be able to improve the syst
Unfortunately, simulation output rarely identifies causes of problems, but only rep
the symptomatic behavior of problems. Bottleneck activities, for example, are usu
identified by looking for locations or queues that are nearly always full which fee
into one or more locations that are sometimes empty. Detecting the source of the bot-
tleneck is sometimes a bit trickier than identifying the bottleneck itself. Bottlenec
may be caused by excessive operation times, prolonged delays due to the unava
ity of resources, or an inordinate amount of downtime. The ability to draw correc
inferences from the results is essential to making system improvements. 

3.1.8 Step 6:  Reporting the Results

The last step in the simulation procedure is to make recommendations for impro
ment in the actual system based on the results of the simulated model. These 
recommendations should be supported and clearly presented so that an informe
sion can be made. Documentation of the data used, the model(s) developed and
experiments performed should all be included as part of a final simulation report

A simulation has failed if it produces evidence to support a particular change whi
not implemented; especially if it is economically justified. The process of selling s
96 ProModel User’s Guide 
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ulation results is largely a process of establishing the credibility of the model. It is
enough for the model to be valid, the client or management must also be convinced of 
its validity if it is to be used as an aid in decision making. Finally, the results mus
presented in terms that are easy to understand and evaluate. Reducing the resu
economic factors always produces a compelling case for making changes to a s

In presenting results it is important to be sensitive to the way in which recommen
tions are made. It helps to find out whether recommendations are being sought o
whether a simple summary of the results is wanted. It is generally wise to presen
alternative solutions and their implications for system performance without sugg
ing one alternative over another, particularly when personnel changes or cuts ar
involved. In fact, where there may be careers on the line, it is best to caution the
sion maker that your simulation study looks only at the logistical aspects of the 
system and that it does not take into account the potential reactions or potential 
culties employees may have in accepting a particular solution.

Animation and output charts have become an extremely useful aid in communic
the results of a simulation study. This usually requires that some touch-up work 
done to create the right effect in visualizing the model being simulated. In prepar
the results, it is often necessary to add a few touch-ups to the model (like a full d
rehearsal) so the presentation effectively and convincingly presents the results o
simulation study. 

After the presentation is finished and there is no further analysis to be conducted
final presentation always seems to elicit further suggestions for trying this or that 
the model), the model recommendations, if approved, are ready to be implement
the simulation has been adequately documented, it should provide a good functi
specification for the implementation team.

3.1.9 Pitfalls in Simulation

If the steps that have been outlined are followed, the chances of performing a su
ful simulation project are very good. Typical reasons why simulation projects fail 
include the following:

• Failure to state clear objectives at the outset.
• Failure to involve individuals affected by outcome.
• Overrunning budget and time constraints.
• Failure to document and get a consensus on input data.
• Including more detail than is needed.
• Including variables that have little or no impact on system behavior.
• Failure to verify and validate the model.
• Basing decisions on a single run observation.
• Basing decisions on average statistics when the output is actually cyclical.
• Being too technical and detailed in presenting the results to management.
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3.1.10 Summary

A simulation project has distinct phases that must be understood and followed in
order to be successful. Simulation requires careful planning with realistic goals a
expectations. Steps to performing a simulation study include planning the study,
defining the system, building the model, conducting experiments, analyzing the o
put, and presenting the results. Systematically following these steps will help avo
the pitfalls that frequently occur when conducting a simulation study. 
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3.2 Modeling Environment
When you open a model or select New from the File menu, your screen appears
shown below with a menu bar across the top of the screen and a layout window.
now, let's look briefly at the menus accessible from the menu bar.

3.2.1 Menu Bar

All of the tools necessary to build and run a model and view the corresponding ou
are accessed through the menu bar. The menu bar is located just beneath the P
Model caption bar and contains the selections listed on the following page. Thes
selections access other menus with selections related to the menu heading.

File  The File menu allows you to open new models, save current models, merge
or more models into one, and load models created with earlier versions of ProM
It also allows you to view a text version of the model and print either the model te
file or the graphic layout of the model.

Edit   The Edit menu contains selections for editing the contents of edit tables a
logic windows. The selections available from this menu will change according to
module from which the Edit menu is selected. They also vary according to the cu
rently selected window.

Menu Bar
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View   The View menu lets you control the ProModel’s appearance. From this m
you can control layout settings, hide or view hidden paths, operate the zoom con
and more.

Build   The Build menu contains all of the modules for creating and editing a mo
This includes the basic modules such as Locations, Entities, Arrivals and Proces
and the optional modeling elements such as Variables, Attributes, Arrays and 
Subroutines.

Simulation   The Simulation menu controls the execution of a simulation and co
tains options for running a model, defining model parameters, and defining and 
running scenarios.

Output   The Output selection starts the ProModel Output Program for viewing 
model output. It also allows you to view the trace which was generated during ru
time.

Tools   The Tools menu contains various utilities including AutoBuild, the Graph
Editor for creating and modifying graphic icons, and a search and replace featur
finding or replacing expressions throughout a model.

Window   The Window menu allows you to arrange the windows (or iconized win
dows) that are currently displayed on the screen such that all windows are visibl
once. It also allows you to bring any individual window to the forefront of the disp

Help   The Help menu accesses the ProModel On-line Help System.
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3.2.2 Window Menu

The Window menu allows you to rearrange windows and icons and select the ac
window. These functions are standard to all Windows applications.

Tile    Causes all open windows to fit in the available screen space. Windows that
be hidden behind other windows become visible.

Cascade    Causes all open windows to overlap such that the title bar of each win
is visible.

Arrange Icons    Causes all icons representing iconized applications to be arran
neatly along the bottom of the screen.

Below Arrange Icons  is a list of the open windows. The window with the check 
next to it is the active window.

Reset the windows to their default positions:

• Choose Reset Window Positions  from the View  menu.

� Note

� How To
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3.2.3 Help Menu

The ProModel Help menu is a convenient, quick way to look up information abou
task you are performing, a feature you would like to know more about, or a comm
you want to use. ProModel Help is available whenever you see a Help command
ton, or Help as an item on a menu bar.

The selections from the Help Menu are as follows:

Index   Brings up the Main Help Index.

Context   Opens the help system to the topic related to the currently active wind

ProModel Support on the Web    When you select this option from the help men
ProModel automatically connects you with the ProModel customer service page
the PROMODEL web site.

About ProModel   Displays a message containing information about the produc
102 ProModel User’s Guide 
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3.2.4 Right-Click Menu

To simplify many of the steps required to perform common modeling operations,
Model now includes a variety of right-click menus. From these menus, you can ac
context-sensitive options and settings for variables, locations, processing, path n
works, resources, and other components. The following menu appears when you
click on the layout.

The right-click layout menu includes the following options:

Edit Background Graphic   Only when you have a background graphic defined
this option appears and lets you edit the graphic.

Snap to Grid   Selecting this option snaps all graphics to the grid.

Show Grid   When you select this option, ProModel displays the background gri

Show Hidden Networks   Displays all hidden networks.

Show Routing Paths   Displays all routing paths used in the model.

Views   From this option, you may select from the views defined in the model.

Zoom to Fit Layout   This option resizes the model to fit the entire image in the
layout window.

Zoom   Allows you to select the zoom percentage.

Layout Settings   From here, you may select and define the grid settings, back-
ground color, and routing color.

Refresh Layout   This option refreshes the image to reflect recent changes.

For information about the right-click menus for model elements (e.g., locations, v
ables, routings, resources, path networks, queues, conveyors, etc.), see Defining Gen-
eral Elements on page 197.

�Note
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3.3 Building a Model
ProModel gives you the flexibility to create a model in several ways. The easiest
method is to use the graphical point and click approach to first define locations in
system. Once locations have been defined, entities (parts) are defined and sche
to arrive at locations in the system. Then you define any optional model elements
as attributes, variables or arrays that will be used in the processing. Finally, the p
cessing of entities at each location is specified in the processing logic.

3.3.1 Using the AutoBuild Feature

If you are new to simulation or are unsure of which elements to include in a mod
ProModel offers a structured environment called the AutoBuild feature to guide y
through the required and optional modeling elements. Since we will use the Auto
Build feature to build our demonstration model, let's examine how it works.

Use AutoBuild:

• Choose Autobuild from the Tools menu.

The start of your AutoBuild session begins with the following dialog box.

You would select New Model  to begin building a model from scratch or Open 
Model  if you wish to modify an existing model.

Certain elements must be included in every model. The required elements are:

• Locations

• Entities

• Processing

• Arrivals

� How To
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Once you are in AutoBuild mode, you are prompted to enter information in the G
eral Information dialog. ProModel then prompts you to select any optional eleme
to include in the model with the following dialog:

Modules are completed by filling out information in an edit table specific to each 
module. When you finish defining the information in a module, click on the upper 
corner of the edit table to close the module. You will then be prompted to go to th
next module.

AutoBuild is flexible enough to allow you to jump back and forth between build m
ules. Once the AutoBuild session has begun, you may enter any other module to
an addition or change and then return to AutoBuild where you left off. To do this, 
ply select another module and make the desired change or addition. When comp
exit the module by closing the module window. The AutoBuild feature will then ta
over and return you to the next uncompleted module. For example, if the Entities
module was not complete, AutoBuild would return you to that module, otherwise
AutoBuild would take you to the next uncompleted module.
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3.3.2 Modeling Scenario

Before we actually begin building a model, let's look at a fictitious scenario for ou
model building session.

Cogswell Cogs has just secured a contract to produce a new cog for production 
X-95C Family Space Cruiser. The current capacity of the Cogswell facility is not 
quate to handle any additional work load while continuing to fill existing orders. 
Therefore, Mr. Cogswell has ordered the I.E. department to simulate the design 
new workcell dedicated to the production of the new cog.

The process consists of loading a cast blank onto an NC mill for milling of the out
splines. Once the splines have been cut, the cog must be degreased, inspected 
loaded with an inner bearing. All operations, including inspection, are to be per-
formed by a single operator.

Model Elements

In building this model we must define all of the basic modeling elements and a fe
the optional elements. 

Locations

We need some type of receiving location to hold incoming entities. We also need
cessing locations where entities have value added to them. For the given produc
rate, Cogswell's engineers have determined that the workcell will require two 
NC_300 series numerically controlled mills, a degreasing machine, and an inspe
assembly station.

Entities (Parts)

The entity types in this system include Pallets, each carrying six cast Blanks. Bla
become Cogs after processing, and Bearings are loaded at the Inspect station. If
fails the inspection it will be called a Reject.

Arrivals

Cogswell's engineers have determined that Pallets should arrive at the rate of 1 
every 45 minutes.

Processing

The operation at each mill requires an operator to load the Blank, which takes a 
mally distributed amount of time with a mean of 3 minutes and standard deviatio
.2 minutes (i.e., N(3,.2)). After a blank has been loaded, the machining time is a
stant 5.7 minutes.
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Cogs are then removed from the mill and placed in the degreasing machine. The
degreasing machine has capacity for 2 Cogs, and has a cycle time of 5 minutes.

Once the Cogs have been degreased, they are inspected for proper spline depth
bearing is installed in the center hole. This process requires the cell operator, an
takes U(3.2,.3) minutes for the inspection and U(1.5,.2) minutes for the Bearing t
installed. If the Cog fails inspection, no Bearing is installed.

Resources

A single operator, CellOp, performs all manual operations.

Path Networks

In order to make CellOp a mobile resource, we must define a path network. We'l
it CellNet.

Attributes

An attribute is simply a “numeric tag” attached to either an entity (entity attribute
a location (location attribute). Since each Cog is inspected for proper spline dept
attach an attribute called Test to each Cog, specifying the Pass/Fail status of the

User Distributions

We will sample from a user defined distribution and set the Test attribute to eithe
(for pass) or 0 (for fail). Ninety six percent of the Cogs pass inspection and have 
Test attribute set to one. Four percent fail the inspection and have their Test attri
set to zero.
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3.3.3 Phased Modeling Approach

Instead of trying to build the model all at once, you may want to implement a pha
modeling approach where you build the model in stages. This will help you to un
stand the basic modeling elements before moving on to more complex ones like
attributes and if-then logic. The following pages walk you through this phase 
approach step by step.

Phase 1: Basic Model Elements

In the first phase you input all of the basic model elements: General Information,
Locations, Entities, Arrivals, and Processing. You also import a background grap
to help in placing the locations in the layout window. Upon completion of this pha
you have a fully working model, ready to animate and collect output.

Phase 2: Adding Resources & Variability

The second phase consists of adding an operator (resource) and corresponding
network to move entities from location to location. This operator is also used to l
and unload the machines, and perform the inspection of the splines. Because hu
operators introduce variability into the system you will change some of the proces
times from constants to distributions to reflect this variance.

Phase 3: Additional Operations

The final phase consists of adding the assembly operation at the inspection stat
Cogs that pass inspection are loaded with a Bearing in the center hole. In doing 
you will use IF...THEN logic to test whether or not the Cog has passed or failed th
inspection. If the Cog passes inspection, a JOIN command is used to accomplis
assembly.

The final task in this phase is to add downtimes for machine failure at each of the
milling machines. You will base the time between failures on the total amount of 
cessing time incurred by each machine. When a machine fails, you will require t
operator to service the machine.
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3.3.4 Phase 1: Basic Model Elements

The first step in building the model is to define the model’s basic elements. To do
select New Model from the initial AutoBuild dialog box.

To use AutoBuild:

• Choose AutoBuild from the Tools menu. The AutoBuild selection dialog 
is displayed.

Selecting New Model  displays the AutoBuild Options dialog. 

AutoBuild Options

From the AutoBuild Options dialog, choose optional model elements to include i
your model. For this example, select Attributes, User Distributions, Path Network
and Resources.

After clicking OK from the AutoBuild Options dialog box, AutoBuild takes you bac
to the General Information dialog and allows you to edit your selections. The Au
Build feature is flexible enough to allow you to move to another module, perform
some action, and then return to where you left off. 

� How To
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For example, suppose you want to import the background graphic of a workcell 
before defining locations. First, import the graphic into the background, then retu
the AutoBuild procedure by closing the Background Graphics module and select
AutoBuild from the Tools menu.

General Information

The General Information dialog box allows you to name your model and specify 
default information such as time and distance units. You also specify the name o
graphics library to use. In this case it is PROMOD4.GLB.

When you click OK in the General Information dialog, AutoBuild takes you first 
through each of the required modules and then through the optional modules yo
selected. 

AutoBuild prompts you with dialog boxes like the following one each time you co
plete and close a module. For simplicity, we will not show the dialog boxes for ea
module.

�Note
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To move to another module and return to AutoBuild:

1. At the ProModel AutoBuild dialog shown below, click Cancel .

2. Select the menu item for the other module and perform the action(s).

3. Click AutoBuild  from the Tools  menu. The above dialog reappears.

Importing a Background Graphic

Simple background graphics such as the one below are imported easily through
Background Graphics Editor. ProModel also allows you to import complex graph
files such as AutoCAD drawings to use as the background for your simulations. F
more information on how to import a background graphic, see Background Graphics 
Editor on page 404.

Often, importing a background graphic makes the process of placing locations e
or altogether eliminates the need to create graphic icons for locations.

� How To
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Defining Locations

Locations are defined easily by selecting the desired icon and placing it in the la
window. Each time a location is placed in the layout window, a corresponding rec
is entered in the Location edit table. This table lists each location along with loca
parameters such as the capacity, number of units, and downtime information. Fo
more information on how to define a location, see Locations on page 201.

Layout Window ( maximized )

Location Edit Table
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Defining Entities

Once all locations have been defined, we define entities in a similar way by sele
an icon for each entity type. As we do this, a record is created in the Entity edit t
for each entity type. For more information on how to define entities, see Entities on 
page 237.

In this model the Speed (fpm) column is irrelevant since all entities move accordin
the definition of the mobile resource CellOp. Also, the Stats column shows that w
desire detailed statistics for all entity types. “Time series” statistics include throu
put history of the entity. “Basic” statistics include only the total exits of each entit
type from the system and the final quantity of each entity type in the system.

Defining Arrivals

Of the four entity types, only one needs to be scheduled to arrive in the system. E
45 minutes one Pallet arrives at the Receiving location. The word “INFINITE” in 
Occurrences column means that one pallet continues to arrive every 30 minutes
long as the simulation runs. For more information on defining arrivals, see Arrivals on 
page 315.
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Defining Process Logic

The last step in defining Phase 1 of our model is to define the processing of entit
each location. ProModel simplifies this task by allowing you to select an entity ty
and then use the mouse to click on the locations in the order in which they will p
cess the entity. Each time you click on a location, a new processing record is add
the Processing edit table, defining the process for that entity type at that location
more information on defining process logic, see Processing on page 295, and Opera-
tion Logic on page 499.

Once the basic entity flow has been defined using the point and click method, op
tion statements are added to the processing logic. The processing logic can be a
simple as a constant operation time or as complex as a nested IF...THEN...ELSE
statement.

Process editing actually involves two edit tables that normally appear side by sid
The Process edit table specifies what happens to an entity when it arrives at a loc
and the Routing edit table specifies where an entity is to be sent once processin
complete.

Process Edit Table

Routing Edit Table
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Process and Routing Logic

The entire process and routing tables for the Phase 1 model are shown below. T
table reads as follows: 

1. When an entity called Pallet arrives at location Receive there is no operation
or processing logic (it's just a storage location). The resulting output is six ent
called Blank that are routed to the FIRST available destination of either 
NC_301L or NC_302L.

2. When Blanks arrive at NC_301L or NC_302L, the processing time is a norm
distribution with a mean of 3 and a standard deviation of .2 minutes. The nam
the entity is now changed to Cog, and the Cog is sent to the Degrease locat
(FIRST is the default routing rule).

3. Two Cogs are accumulated at Degrease and processed for 5 minutes. Whe
degrease cycle is complete, Cogs are routed to location Inspect.

4. The inspection time is a uniform distribution with a mean of 3.2 and a half ra
of .3 minutes. Ninety six percent of the Cogs pass inspection and exit the sys
while four percent of the Cogs fail inspection and become Rejects.

Entity Location Operation (min)  Blk Output Destination Rule Move Logic
Pallet Receive 1 Blank NC_301L FIRST 6 MOVE FOR .5

Blank NC_302L FIRST MOVE FOR .5
Blank NC_301L WAIT N(3,.2) 1 Cog Degrease FIRST 1 MOVE FOR .5
Blank NC_302L WAIT N(3,.2) 1 Cog Degrease FIRST 1 MOVE FOR .5
Cog Degrease ACCUM 2

WAIT 5
1 Cog Inspect FIRST 1 MOVE FOR .5

Cog Inspect WAIT U(3.2,.3) 1 Cog EXIT 0.960  1
Reject EXIT 0.040

� Process Table                                         Routing Table
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3.3.5 Phase 2: Adding Resources & Variability

In this phase we wish to add the operator, CellOp, to move entities from location
location, and to perform the loading, unloading, and inspection operations. The e
est way to add the necessary model elements is to once again allow AutoBuild t
guide us through the necessary steps. ProModel requires that all dynamic resou
travel on a path network. Therefore, for Phase 2, we need to define resources an
networks.

Defining Path Networks

Path Networks consist of nodes and path segments which connect nodes to oth
nodes. Each location where a resource may stop to pick up, drop off, or process
ties must interface with a path node.

We define path networks through the Path Network edit table similar to the previ
edit tables. For each network we specify the nodes and path segments connecti
nodes. Some of the heading buttons, such as Paths and Interfaces, bring up oth
tables such as the Path Segment Edit table shown below. For more information o
defining path networks, see Path Networks on page 243.

Path Network Edit Table

Path Segment Edit Table
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Defining Resources

Resources are defined in much the same way as entities. When in the Resource
ule we simply select an icon to represent the resource and then specify the 
characteristics of the resource in the Resource edit table. For more information a
defining resources, see Resources on page 261.

The Resource edit table shown below contains fields for specifying the name an
number of units of a resource. It also has fields for specifying resource downtime
(DTs...), the level of statistics to collect (Stats...), which path network used for tra
(Specs...), and any work and park search routines (Search...). Clicking the mous
any of these buttons brings up separate edit tables for specifying this data.
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Process Editing

Now that we have defined a resource, we must specify how and when that resou
used in the processing logic.

In the Phase 1 model we used only constant processing times. Now, due to varia
associated with the operator, we must represent the loading and inspection time
distributions.

In the example below, CellOp loads the blank at mill NC_302L and is then FREE
perform other operations. When the Blank has finished processing, the entity is 
moved with the CellOp to the degreasing machine.

Process Edit Table and corresponding operation logic
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Routing Edit Table

Process and Routing Logic

The complete process and routing logic is shown below, with CellOp used to per
the loading operations at each mill and inspect the Cogs at the Inspect location.
lOp is also used to transport entities from location to location. All additions or 
changes to the Phase 1 model are shown in bold type.

With the new processing now defined, we have specified all of the necessary mo
ing elements. We are now ready for the model execution phase. Once again, we
defer discussion of model execution until we have finished the final phase of the
model.

Entity Location Operation (min)  Blk Output Destination Rule Move Logic
Pallet Receive 1 Blank NC_301L FIRST 6 MOVE WITH CellOp

Blank NC_302L FIRST MOVE WITH CellOp
Blank NC_301L WAIT N(3,.2)

FREE CellOp
WAIT 5.7

1 Cog Degrease FIRST 1 MOVE WITH CellOp

Blank NC_302L WAIT N(3,.2)
FREE CellOp
WAIT 5.7

1 Cog Degrease FIRST 1 MOVE WITH CellOp
  THEN FREE

Cog Degrease ACCUM 2
WAIT 5

1 Cog Inspect FIRST 1 MOVE WITH CellOp

Cog Inspect WAIT U(3.2,.3)
FREE CellOp

1 Cog EXIT 0.960  1
Reject EXIT 0.040

� Process Table                                  Routing Table
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3.3.6 Phase 3: Additional Operations

In the final phase of our modeling session we want to demonstrate an assembly
ation by using the operator to install a Bearing into the center hole of the Cog if (
only if) the Cog passes inspection.

Once we have defined the attribute and distribution table, we must return to the 
tions, Entities and Arrivals modules to define a new location called Bearing_Que
new entity called Bearing, and an arrival schedule for the Bearings.

In addition, we also need to specify a usage based downtime for mills NC_301L
NC_302L from the Location module.

The final step in completing this phase of the model is to edit the processing log
include the assembly. We will use the built-in JOIN construct to accomplish the 
assembly.

Defining Attributes

AutoBuild takes us to the Attribute module where we enter the Attribute edit tabl
define an Entity Attribute called Test that holds integer values. We set this attribu
one if the Cog passes the inspection, or zero if it fails the inspection. For more in
mation about defining attributes, see Attributes on page 413.
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Defining a Distribution

In order to determine if an entity passes or fails the inspection, you sample from
user-defined distribution called Dist1 (alternately, you could use the RAND() func
tion). To define the distribution, simply click the mouse on the Table... button and
in the distribution parameters. In this case, 96% of the entities pass inspection an
fail.

New Location, Entity, and Arrival 

Before we can assemble the Cog at the Inspect location we must first define the
entity type called Bearing in the Entities module. We must also define a new loca
Bearing_Que, to hold the Bearings, and an arrival schedule for the Bearings. To
this we simply open the appropriate module as in Phase 1 and supply the inform
For simplicity we'll skip the details and move on to downtime specification.
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Defining Location Downtimes

In order to represent machine failure times for the two mills, NC_301L and 
NC_302L, we click on the DT... button in the Location edit table shown below. Th
brings up another edit table for specifying a downtime based on machine usage.
more information about defining location downtimes, see Locations on page 201.

In the example above, we have defined failures to occur according to an expone
distribution with a mean of 30 minutes. When a machine fails, resource CellOp i
required to service the machine.
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Process and Routing Logic

The process and routing table below shows all of the changes and additions to t
Phase 2 model in bold text.

This concludes the final phase of our model building session. We now turn our fo
to running the model.

Entity Location Operation (min)  Blk Output Destination Rule Move Logic
Pallet Receive 1 Blank NC_301L FIRST 6 MOVE WITH CellOp

Blank NC_302L FIRST MOVE WITH CellOp
Blank NC_301L WAIT N(3,.2)

FREE CellOp
WAIT 5.7

1 Cog Degrease FIRST 1 MOVE WITH CellOp

Blank NC_302L WAIT N(3,.2)
FREE CellOp
WAIT 5.7

1 Cog Degrease FIRST 1 MOVE WITH CellOp
  THEN FREE

Cog Degrease ACCUM 2
WAIT 5

1 Cog Inspect FIRST 1 MOVE WITH CellOp
  THEN FREE

Cog Inspect WAIT U(3.2,.3)
Test = Dist1()
IF Test = 1 THEN
  BEGIN
    JOIN 1 Bearing
    WAIT U(1.2,.2)
    FREE CellOp
    ROUTE 1
  END
ELSE
  BEGIN
    FREE CellOp
    ROUTE 2
  END

1 Cog EXIT FIRST 1
2 Reject EXIT FIRST 1

Bearing Bearing_Que 1 Bearing Inspect JOIN  1 MOVE FOR .05

� Process Table                                   Routing Table
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3.4 Running a Model
Running a model is a fun and easy process. Models are compiled automatically a
time, keeping you apart from any complex compilation process. If your model co
tains any errors, a detailed message explains the nature of the error and points 
module and line number where the error occurred. In most cases you are permit
make changes on the fly.

ProModel uses concurrent animation, which means that the animation occurs wh
the simulation is running. Concurrent animation has many advantages over post-
lation animation. By eliminating the two-step process of running the simulation a
then animating it, you save valuable time. Concurrent animation immediately allo
you to see if a model is working properly.

3.4.1 Simulation Options

When you select Options from the Simulation menu, ProModel displays the Sim
tion Options dialog. This dialog contains several options for controlling the 
simulation, such as the run length, warm-up period, clock precision, and the nam
the output file. You can also set the number of replications and the level of detail 
collected for the statistics. For more information about Simulation options, see Simu-
lation Options on page 569.
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The maximum run length depends on the clock precision and the time unit select
shown in the following table.

3.4.2 Animation Screen

The ProModel animation screen has a menu of its own, with selections for contro
many simulation parameters (such as run speed). You can also control the anim
through panning, zooming, and pausing.

The screen above shows the speed control bar, along with the clock selection bu
for controlling the format of the clock readout. In addition, each machine or statio
has a status light which changes throughout the simulation to reflect the current 
ational state of each machine or station.

The File menu includes an option for viewing a text file of the model as the mode
running. This is an excellent way of checking to make sure the model is doing wh
is supposed to do!

Next we'll take a look at two of the other menu items: Options and Information.

CLOCK PRECISION

Time Unit .01 .001 .0001 .00001

Seconds (sec) 11,930 hrs 1,193 hrs 119 hrs 11 hrs

Minutes (min) 715,827 hrs 71,582 hrs 7,158 hrs 715 hrs

Hours (hr) 42,949,672 hrs 4, 294,967 hrs 429,496 hrs 42,949 hrs

Speed Control Bar Clock Selection Button
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3.4.3 Options Menu

The Options menu contains several options that allow you to track events in the 
tem as they occur. The Debugger is a convenient and efficient way to test or follow
processing of any logic defined in your model. The debugger is used to step thro
logic one statement at a time and examine variables and attributes while a mode
running. A Step Trace allows you to step through the system events one at a tim
clicking on the left mouse button. A Continuous Trace allows you to step through
tem events continuously without clicking the mouse.

 

The following Trace window shows system events as they occur in the animation.
number in the left hand column represents the simulation time when the event 
occurred, while the text describes the event. Stepping through the events is an e
lent way to verify and debug a model.
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Other options include: Animation Off, which makes the simulation run considera
faster; Zoom, which allows you to zoom in or out to any degree on the animation
Views, which allows you to quickly and easily access specific areas of the model
out window (see Model Parameters & Scenarios on page 575); and User Pause, whic
allows you to specify the time of the next simulation pause.

3.4.4 Information Menu

The Information menu contains selections for obtaining system information durin
the run. Select Status Light to bring up a Location Status Legend that defines th
ors of the status light on each machine.

For up-to-the-minute location information, such as current location contents and 
number of entries, select Locations from the Information Menu. The following inf
mation is for one location, OriginatorComp.
128 ProModel User’s Guide 



 Section 3.5  Viewing Model Statistics & Reports

3.
5

stem 
een 
 
 in 

lect 
k. 
he 

t 
 

 col-
erall 
 of 
 each 

k 
ing 
3.5 Viewing Model Statistics & Reports
The purpose of any simulation model is to gain a deeper understanding of the sy
under study. ProModel's output generator helps you to see the interactions betw
various system elements through tabular and graphical representation of system
parameters such as resource utilization, throughput history, cycle time, and work
process levels. 

After each simulation run you are prompted to view the model output. You can se
yes to view the results immediately, or select no to continue with some other tas
Selecting yes opens the Statistics Viewer and automatically loads the output of t
most recent model run.

The STAT module can be run directly from within ProModel, or as an independen
application separate from ProModel. You can load a single results file or several
results files from different models for comparison of selected statistics. 

Model output is written to several output files according to the type of data being
lected. The main output file contains information of a summary nature such as ov
location utilization and number of entries at each location. Other files keep track
information such as location contents over time and the duration of each entity at
location.

In order to see the power and flexibility of the ProModel output generator, we loo
next at some of the tabular and graphical output. For more information about view
a simulation’s output, see Reports & Graphs on page 619.
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3.5.1 General Statistics Report

The General Stats report summarizes information for each location, entity, and 
resource contained in the output file <model name>.RDB.

Although the entire file is not visible in this window, scroll bars on the bottom and
right hand side of the window allow you to scroll through the entire file.

Summary information for locations is divided into two categories, one for single 
capacity locations and one for multi-capacity locations. This is due to the fact tha
many of the fields in the multi-capacity section, such as Max Contents, do not ap
to single capacity locations.

For more information about a simulation's tabular output, see Creating Reports on 
page 631.

The following graphs are derived from the data in the file above and represent ju
small sample of the many possible graphical representations of the data.
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3.5.2 Selected Statistics Report

The Selected Stats report is an optional report when multiple replications, batch
means, or periods have been defined. Information for specific selections you ma
displayed in the following dialog.

The selections in the dialog above produce the following report:

Although the entire file is not visible in this window, scroll bars on the bottom and
right side of the window allow you to scroll through the entire file. For more inform
tion about a simulation's tabular output, see Creating Reports on page 631.
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3.5.3 State & Utilization Graphs

The Output Program allows you to create different types of state and utilization 
graphs to illustrate the percentage of time that locations, resources, and entities 
a particular state: operation, waiting, blocked, down, etc. For more information a
state and utilization graphs, see Creating Graphs on page 647.

Location Utilization Graph

Location Utilization graphs show the percentage of time each location in the sys
was utilized. ProModel allows you to see this information for any or all of the loca
tions in the system. 

This location utilization graph displays all single capacity locations in the model.
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Location State Graphs

Single and Multiple Capacity Location State graphs show the percentage of time
location in the system was in a particular state, e.g., idle, in operation, waiting fo
arrivals, blocked or down for single capacity locations. ProModel allows you to se
this information for all locations in the system at once. 

For an alternative graphical view of one of the locations, simply click the mouse 
any one of the bar graphs to create a pie chart for that location as shown below.
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Multiple Capacity Location Downtime Graph

Multiple Capacity Location Downtime graphs show the percentage of time each 
multi-capacity location in the system was down. A pie chart can be created for a
one of the locations.

Resource Blocked In Travel Graph

Resource Blocked in Travel graphs show the percentage of time a resource was
blocked. A resource is blocked if it is unable to move to a destination because the
path node along the route of travel was blocked (occupied).

Resource Utilization Graph

Resource Utilization graphs show the percentage of time each resource in the s
was utilized. A resource is considered to be utilized whenever it is not idle, traveling 
to park, or down. ProModel allows you to see this information for all resources in
system at once.

Resource State Graph

Similar to location state graphs are resource state graphs which show the relativ
amount of time each resource spent in a particular state. The graph below show
state of the single resource Crane1 and Crane2 . From this graph we see immedi-
ately that Crane2  is only 25% utilized.

Once again, a pie chart for any resource is just a mouse click away! Click on the
of the graph and the Output Program displays a pie chart for the resource.
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Entity State Graph

Entity State graphs show the percentage of time an entity is in a particular state,
in transit, waiting for a resource, in operation, or blocked. Click directly on the 
desired bar of the graph to display a pie chart for that entity.

3.5.4 Time Series Plots & Histograms

In previous versions of ProModel, time series plots and histograms were known 
throughput, content, value, and duration plots and histograms. These charts can
be combined on one chart for improved comparisons. Time series statistics can b
lected for locations, entities, resources, and variables. See Defining General Elements 
on page 197 and Defining Advanced Elements on page 411 for more information on 
selecting the type of statistics to be collected for these elements.

When you select one of the Time Series menu item choices, a dialog appears, a
ing you to select the values to graph and the options to customize their appeara
For more information about time series graphs, see Creating Graphs on page 647.
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Time Series Histogram

The graph below shows a content histogram for the cycle_time  variable. The 
selected time interval is 90 minutes. 

Selecting Edit  from the Options  menu displays the Graph Options dialog that 
allows you to select time units, bar width, and other options to modify the look of
your graph. The following graph represents the same information as the one abo
but helps you identify the information and understand it better.
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Time Series Plots

Time Series Plots give you a different perspective from histograms. You can track
bal variables such as total time accumulated and work-in-process value history. 
following plot shows the total_time_accum  Value History and the WIP (work in 
progress) Value History  over a 90 minute period.
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